PUBLISHER-TABLES
Another way to present information in a frame is by using a table. A table is used to place
information in rows and columns, which makes it easy to arrange information in an easily
accessible format.
Create/Insert Table-Insert Table Grid
 Click the Insert Tab.
 In the Tables Group, click the Table button (see illustration below).

 A grid of cells will display (see illustration above).
 Move the mouse pointer over the squares to select the number of columns and rows for the
table.
 Click the left mouse button.
 The table will appear in the publication.
Create/Insert Table-Insert Table Dialog Box
 Click the Insert Tab.
 In the Tables Group, click the Table button (see illustration below).
 Click the Insert Table link.
 The Insert Table dialog box will display (see illustration below).

Change the Location of a Table
Tables can easily be moved to other locations the same as other objects in a publication.
 Place the mouse pointer on the edge of the Table Frame.
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 When the mouse pointer changes to a four headed arrow, drag the table to a new location.
 When the table is in the correct position, release the mouse button.
Table Tools Design Tab
This tab is used to change the design of the table, as well as to change the fill and line colors,
arrange the table on the page and to change the size of the table.

Group and Button
Table Formats Group
Table Design Gallery

Fill
Format Shape

Borders Group
Line Weight
Line Color
Borders

Description
This gallery is used to apply a pre-formatted design to the table. Move
the mouse pointer over each design to see a Live Preview. To see more
designs, click the arrows or the More button at the end of the gallery.
Use this button to fill the selected cell(s) with a solid color. Click the
More Colors button to see a gallery of additional colors.
This feature will open the Format Table dialog box. This dialog box is
used to fine-tune the look of the table. This button appears in the
lower-right corner of the Table Formats Group.
To change the width of the line for border, click this button. A gallery
of different border line widths will appear.
This button is used to change the color of the line for the border.
Use this button to specify where the border will appear in the cell. A
gallery of different options will display.

Word Art Styles Group
Word Art Styles
This feature is used to add some artistic flair to text within a table, such
as the title. The button in the bottom-right corner of the gallery is used
to display additional artistic effects.
Text Fill
To change the fill color of the Word Art, select this button. A gallery of
different colors will display. Click the More Colors link to display a
grid of additional colors.
Text Outline
Select this option to change the color and weight of the outline of the
Word Art. A gallery of different colors will display. Click the More
Outline Colors link to display a grid of additional colors.
Text Effects
This feature can be used to add a reflection, shadow, glow, or 3-D effect
to the Word Art image. Move the mouse pointer over each of the items
to display a gallery of available options.
Text Fill Effects
To open the Format Shape dialog box, click this button. This button
appears in the lower-right corner of the Word Art Styles Group.
Typography Group
Drop Cap
To apply a large capital letter to the beginning of a paragraph, use this
button.
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Group and Button
Number Styles
Ligatures
Stylistic Sets
Swash
Stylistic Alternatives

Description
Click this button to select a display style for the numbers that have
been input into the text box.
Use this button to turn on ligatures for the selected text. Ligatures are
used to tie two or more letters together.
This button is used to select a set of alternative character shapes for the
selected text.
This button is used to turn on flourishes for the selected text. Flourishes
are looped or curly lines that are added to text.
To choose a different character shape for the selected text, click this
button.

Table Tools Layout Tab
This tab is used to select rows and columns in the table, to insert new rows or columns, to merge
cells within the table, or to align the text within a table. The table below describes the button in
each of the groups on the ribbon.

Group and Button
Table Group
Select
View Gridlines

Description

Click this button to select the current table, cell, column, or row.
This button is used to view gridlines in a table. These lines are used as
a guide when working with a table.
Rows and Columns Group
Delete
When this button is clicked, options for deleting a row, column, or
table will appear. The row or column where the insertion point is
located will be deleted if one of those options is selected.
Insert Above
Click this button to insert a row above the currently selected row.
Insert Below
To insert a row below the currently selected row, click this button.
Insert Left
To insert a column to the left of the currently selected column, click this
button.
Insert Right
Click this button to insert a column to the right of the currently selected
column.
Merge Group
Merge Cells
To merge two or more cells into one cell, select the cells that are to be
merged, and then click this button.
Split Cells
This button is used to split a cell into two or more cells.
Diagonals
Click this button to split the cells diagonally into multiple new cells.
The options are No Division, Divide Down, or Divide Up.
Alignment Group
Align Top Left
Click this button to align the text in a cell vertically at the top of the cell
and horizontally to the left.
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Group and Button
Align Center Left
Align Top Right
Align Top Center
Align Center
Align Center Right
Align Bottom Left
Align Bottom Center
Align Bottom Right
Text Direction
Hyphenation
Cell Margins
Format Shape

Arrange Group
Wrap Text
Bring Forward

Send Backward

Align

Group
Ungroup

Description
Click this button to align the text in selected cells centered vertically
and left aligned horizontally.
Click this button to align the text in a cell vertically at the bottom of the
cell and horizontally to the left.
To align the text in a cell to the top of the cell vertically and centered
horizontally, click this button.
To align the text in a cell in the center of the cell both vertically and
horizontally, click this button.
This button is used to align the text in a cell centered vertically and
right horizontally.
This button is used to align the text in a cell to the top of the cell
vertically and to the right in the cell horizontally.
To align the text in a cell to the bottom of the cell vertically and
centered horizontally, click this button.
This button is used to align the text in a cell to the bottom of the cell
vertically and to the right in the cell horizontally.
To change the direction of the text in a cell, click this button. The
direction will change each time the button is clicked.
Use this button to change the hyphenation behavior for the selected
text.
To change the margins in a cell, click this button. The Table Options
dialog box will display.
This feature will open the Format Table dialog box. This dialog box is
used to fine-tune the look of the table. This button appears in the
lower-right corner of the Table Formats Group.
Click this button to change the way text wraps around a table. A
gallery of different wrap options will display.
In Publisher, it is possible to layer objects. This button is used to bring a
table forward when other objects are placed on top of it. Click the
button to select from Bring Forward or Bring to Front.
When objects are layered in a publication, this button is used to move
the table or other object backward in the group. Click this button to
choose from Send Backward or Send to Back.
Use this button to align the table in relation to the publication margins.
When the button is clicked a gallery of different alignment options will
appear. The Relative to Margins option must be selected in order to
choose the other options.
To join two or more objects so that they appear as one, click this button.
The objects must be selected to activate this button.
Click this button to break a group of objects back into individual
objects.
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Group and Button
Rotate

Size Group
Height

Width

Grow to Fit Text
Format Auto Shape:
Size

Description
This button is used to rotate or flip the selected object. When the button
is clicked a list of different options will display. When objects have
been grouped, the group of objects will rotate or flip, not the individual
objects within the group.
Use this button to change the height of the table or of a selected row.
The height can be typed into the box or the spinner arrows can be used
to change the height of the row.
To change the width of the table or of a selected column, click this
button. The width can be typed into the box or the spinner arrows can
be used to change the width of the row.
This button can be used to allow the table to grow as more text is
added. The check mark in the box indicates that this option is active.
Select this option to open the Format Shape dialog box with the Size
tab selected. In this dialog box, the size and rotation of the table can be
changed.

Align Table
Tables can be aligned relative to the margins in the publication. Once the option has been chosen,
then the alignment can be selected.
 Click the Tables Tools Layout Tab.
 In the Arrange Group, click the Align button.
 Click the Relative to Margin Guides option to select it.

 Click the Align button again.
 Click the Alignment that is to be used for the table.
Size Tables
A table can be resized at any time. When the table’s width is changed all the column widths will
also increase. If the height of the table is changed, the row heights will also change. To resize the
table, do the following:
 Click the table to select it.
 Place the mouse pointer on the appropriate sizing handle.
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 The adjust icon will appear.
 Left-Right – This icon is used to change the width of the table from the left and right
side.
 Up-Down– Use this icon to change the height of the table.
 Diagonal– To change both the width and height of the table, use this icon.
 Once the arrow appears, drag the mouse to increase or decrease the size of the table.
 Release the left mouse button when the table is the appropriate size.
 To maintain the Table’s Height/Width Ratio, select one of the Table’s corner handles.
 The mouse pointer will change to a two-headed diagonal arrow.
 Click and drag the mouse to change the width and height of the table.
Size Table Columns and Rows
As stated before, when a table width or height is changed, the row height and column width are
automatically changed. It is also possible to control individual row height and column width in a
table to better accommodate text entries that are placed in a particular column. To change a
column width or row height, follow the steps below.
 Click the table to select it.
 Place the mouse pointer on a column divider or to the right of the column or below the row
divider that is to be resized.
 The Adjust icon (see illustrations at right) will appear.
 Drag the mouse to increase or decrease the width or height of the column or row.
 Release the mouse button.
 The column or row will be sized accordingly.
 To keep the Table Size the same width or height when widening columns or rows:
 Hold down the Shift key while dragging the Column Width or Height (Adjust) tool.
 The table will stay the same size.
 Only the column is widened.
Move Around a Table
Text can be entered and edited in a cell in the same way that it is entered or edited in a text frame.
The insertion point shows where text that is typed will appear in the table. The table below shows
methods of moving from cell to cell.
Moving from Cell to Cell
To Move
Do This
To any cell, or to text within a cell
Click in the cell or text
To the next cell
Press Tab
To the preceding cell
Hold down the Shift key and press Tab
Forward one character or cell
Press the right arrow key
Backward one character or cell
Press the left arrow key
Up one row or cell
Press the up arrow key
Down one row or cell
Press the down arrow key
Select Parts of a Table
Once a table has been created, text is entered into cells in the same way it is in a text frame. The
first row of the table is good for column headings or a table title. The left-most column is good for
row labels. In order to enter text, it is important to know how to move around the table. Knowing
how to select cells, rows, and columns is essential to working with tables. Cells must be selected in
order to format them, enter text into them, delete unnecessary text, and add or remove rows and

6

columns. It is possible to select and format one cell at a time or to select a range of cells to format.
A range of cells is a group of two or more adjacent cells. The table below provides the directions
for selecting different table parts.
Selecting Table Parts Using the Mouse
To select
A single cell
A range of cells
One or more rows

One or more columns

The entire table

Do this
Drag over the cell or double-click within the cell.
Drag from the cell in the upper-left corner of the range to the cell
in the lower-right corner of the range.
Click the row selector button for the first row to be selected, and
then drag to select the row selector buttons for the other rows that
are to be selected. The row selector is a black arrow that points to
the right.
Click the column selector button for the first column that is to be
selected. Drag to select the column selector buttons for the other
columns that are to be selected. The column selector is a black
arrow that points down.
Click and drag through the columns and rows to select the table.

Select Table Parts Using the Ribbon
It is also possible to select different parts of a table by using the ribbon. Clicking in
the appropriate cell, row, column, or table does this. After the appropriate table
element has been selected, click the Table Tools Layout Tab. In the Editing
Group, click the Select button. Click the option to select the Cell, Column, Row,
or Table.
Select Text in a Table
It is possible to format text in a table in the same way that text in a text frame is formatted. Just
select the text to be formatted, and then apply a new font type, font size, font color, and any other
formatting. The table below provides methods for selecting text in a table.
Selecting Text in a Table Cell
To select
One word
Some text in a cell
All text in a cell
All text in a cell

Do this
Double-click the word.
Drag the I-beam pointer across the text
Click in the cell and press Ctrl+A.
Triple-click in the cell.

Enter Information into the Table
Text is entered into an existing table frame one cell at a time. A cell is the box created by the
intersection of a column or row. Each cell acts like a mini-text frame. Text can quickly be copied
from a selected cell to one or more selected cells either to the right or below the original cell. To
enter text into a table, follow the steps below:
Enter Text into a Cell
 Click the first table cell where text is to be entered.
 Type the text for the first cell.
 Press the Tab key to move to the next cell.
 Enter the text for this cell.
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 Continue this procedure until all the text has been entered.
Insert Identical Text into Several Cells
 Click the cell that is to be copied.
 Drag to select the cell or cells where the text is to be pasted.
 The text can be pasted either below or to the right of the cell containing the text that was
copied.
 Do one of the following:
 Click the Home Tab and then click the Paste button in the Clipboard Group.
 Right-click in the cell where the text is to be copied to and then select Paste.
NOTE: Text can be copied from other programs such as Word and then pasted into the cells.
Choose a Table Design
Publisher provides a variety of designs to choose from, which are called formats. Each format has a
combination of text formatting and alignments as well as cell and table patterns, shading, and
borders. These formats may be modified, if necessary. Formatting may be copied from one cell to
other cells with the Format Painter.
 Click in the table that is to be formatted.
 Click the Table Tools Design Tab.
 In the Table Format Group, click one of the formats for the table from the Table Format
Gallery.
Arrows

More Button
 To see additional format:
 Click the arrows at the end of the gallery.
 Click the More Button (see illustration above).
Format the Table Manually
To format a table border and fill colors manually, the Line Color and Fill Color buttons on the
Table Tools Design Tab may be used.
Add a Fill Color to Certain Cells in the Table,
 Select the cells that are to be formatted.
 Click the Table Tools Design Tab.
 In the Table Format Group, click the arrow at the bottom of the Fill button (see illustration).
Arrows
More Button
 A gallery of different Fill Colors will display (see illustration on next page).
 Choose a Fill Color from the Fill Color palette.
 For additional colors, click the More Colors button.
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 The Colors window will display (see illustration above).
 Click the Standard tab to view a palette of additional colors.
 Click the Custom tab to change the tone of the color.
 Click the PANTONE tab to select more colors.
 Click OK to apply the color to the selected cells.
Add Border Colors to a Table
 Select the entire table or a cell, row, or column in the table.
 Click the Table Tools Design Tab.
 In the Borders Group, click the Line Weight (top) button to change the width of the line (see
illustration below).
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 Click the Line Color button to change the color of the line.
 Click the Borders button to select the borders to be applied to the table or cells.
Use the Format Painter Button
The Format Painter button is used to apply formatting to adjacent or nonadjacent cells in a table.
Clicking the button once applies formatting one time to a cell or group of cells. To apply the same
formatting to several nonadjacent cells, double-click the button and start applying the formatting
to as many cells as desired.
Copy a Cell’s Format
 Select the cell whose format is to be copied.
 Click the Format Painter button in the Clipboard Group on the
Home Tab (see illustration at right).
 Click the cell or drag across a range of cells whose format is to be
changed.
Copy Formatting to Nonadjacent Cells
 Select the cell whose formatting is to be copied.
 Double-click the Format Painter button in the Clipboard Group on the Home Tab.
 Click the cells to which the formatting is to be applied.
 Click the Format Painter button again to turn the Format Painter off.
Merge Cells
The Merge Cells command removes the column dividers between the cells and merges the cells
into one continuous cell. To merge cells in a table, follow these steps:
 Drag to select the cells that are to be merged.
 Click the Table Tools Layout Tab.
 In the Merge Group, click the Merge Cells button (see illustration at
right).
 The cells will be merged into one cell.
Insert a Diagonal Line in a Cell
A cell can be divided diagonally; making the cell in effect two different cells that can contain
different information. To divide a cell diagonally, follow these steps:
 Drag to select a cell or cells in the table to split diagonally.
 Click the Table Tools Layout Tab.
 In the Merge Group, click the Diagonals button (see illustration below).
 Select from one of the options as shown in the illustration below.
 A diagonal line will divide the cell.
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